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 Getting Started with the SAM L10/L11 Xplained Pro

Abstract

This application note aims at getting started with the Atmel® SAM L10 and SAM L11 ARM®Cortex®-M23
based microcontrollers using their respective Xplained Pro evaluation kits.

The Atmel SAM L10 and SAM L11 Xplained Pro evaluation kits are hardware platforms used to evaluate
the ATSAML10E16A and ATSAML11E16A microcontrollers.

Each kit is supported by the Atmel Studio Integrated development Platform, and provides an easy access
to the features of the microcontroller.
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1. Device Documentation

Data Sheet
Web page: http://www.microchip.com/.

Document: SAM L10/L11 Family Data Sheet, which provides peripheral descriptions and electrical
characteristics.

Silicon Errata
Web page: http://www.microchip.com/.

Document: SAM L10/L11 Family Silicon Errata and Data Sheet Clarification.
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2. Obtain the SAM L10/SAM L11 Xplained Pro Evaluation Kit
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X32 HEADER

Web page: http://www.microchip.com/.

To order the kit, accessMicrochip Direct

Documents:

• SAM L10/L11 Xplained Pro User Guide (.pdf)
• SAML10-Xplained-Pro_Design-Documentation (.zip)
• SAML11-Xplained-Pro_Design-Documentation (.zip)

Key Features:
• ATSAML10E16A-AU or ATSAML11E16A-AU microcontrollers
• One mechanical reset button
• One mechanical programmable button
• One QTouch® button
• One user LED (yellow)
• 32.768 kHz crystal
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• ATECC508A Crypto Authentication IC
• Two Xplained Pro extension headers
• One X32 header
• One mikroBUS header
• Embedded Debugger

– Auto-ID for board identification in Atmel Studio
– One status LED (yellow)
– One board power LED (green)
– Symbolic debug of complex data types including scope information
– Programming and debugging, including power measurements
– Data Gateway Interface: SPI, I2C, four GPIOs
– Virtual COM-port (CDC)

• Embedded current measurement circuitry with Atmel Data Visualizer support for data visualization
• USB powered

Tip:  The SAM L10/SAM L11 Xplained Pro User's Guide describes how to power the kit, and it
also describes the detailed information on board components, extension interface and the
hardware guide.
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3. Obtain the Tools
Atmel Studio 7, which uses a GCC compiler, is the preferred IDE to get started with SAM L10/SAM L11
MCUs. Atmel START is the preferred user interface to generate the initial project. Any Atmel START
project can be used in Atmel Studio 7, IAR or KEIL IDEs.

Atmel Studio 7
• Web page: Atmel Studio

Document: Atmel Studio 7.0 web installer(.exe)

Atmel Studio 7 is the preferred IDE for developing and debugging firmware for SAM L10/SAM L11.

Atmel Start
• Web page: Atmel Start

Document: Atmel Start User's guide: Also, use the help menu from the interface.

Atmel Start enables users to select and configure software components and tailor embedded applications
in a usable and optimized manner.
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4. Getting Started With SAM L10/SAM L11 Using Atmel Studio 7 and
START
Note:  The following steps are described using the SAM L10 Xplained Pro as reference; however, the
same sequence can be performed using the SAM L11 Xplained Pro.

4.1 Instructional Guide
Follow these steps to start exploring the Atmel Xplained Pro platform:

1. Download Atmel Studio.
2. Install Atmel Studio.
3. Launch Atmel Studio.

 AN2722
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4. Connect the kit to the PC using a micro-USB cable (Standard-A to Micro-AB).
When the Xplained Pro MCU kit is connected to the computer for the first time, the operating
system will install the software driver. The driver file supports both 32-bit and 64-bit versions of
Microsoft® Windows®XP, Windows Vista®, Windows 7, Windows 8 and Windows 10.

When the Xplained Pro MCU board is powered, the power LED (green) will glow and Atmel Studio
will auto-detect the specific Xplained Pro MCU and extension boards that might be connected.
Atmel Studio will provide links to relevant information, such as data sheets and kit documentation.

Note:  The ATSAML10E16A and ATSAML11E16A devices are programmed and debugged by the
on-board embedded debugger, hence no external programmer or debugger tool is required.

Figure 4-1. Atmel Studio SAM L10/SAM L11 Xplained Pro Introduction

3 © 2016 Atmel Corporation
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5. Launch Atmel Start from Atmel Studio: File > New > Atmel Start Example Project, and then open
Atmel Start directly into Atmel studio.
Figure 4-2. Opening Atmel Start Example Project in Atmel Studio

4 © 2016 Atmel Corporation

Atmel Start will load the existing example list.
6. Choose the example "LED Flasher" in the list, and then click Open Selected Example.

Figure 4-3. Atmel start SAM L1x Available Example List

5 © 2016 Atmel Corporation

c

c

7. Choose either the SAM L10 or SAM L11 Xplained Pro Board, and then click Select board.
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Figure 4-4. Board Selection

6 © 2016 Atmel Corporation
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8. Click GENERATE PROJECT to generate the project from Atmel Start. My "Software Components
Window" will be displayed.
Figure 4-5. Atmel Start Project Generation

9 © 2016 Atmel Corporation

9. The following window will be displayed: Enter Project Name, Solution, Solution Name, and then
browse and choose a location for the project. Click OK to open the project in Atmel Studio.
Figure 4-6. Atmel Studio New Atmel Start Project Importation

10 © 2016 Atmel Corporation

The Atmel Studio will create the project.
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10. Configure the Debugger/Programmer Interface by following these steps:
– Open the project properties: Project > Properties or <ALT+F7>.
– Click Tool.
– For the Selected debugger/programmer, choose "EDBG ATMLxxx".
– For the Interface, choose "SWD".

Figure 4-7. Programming Tool Selection

11 © 2016 Atmel Corporation

11. Compile and run the LED Flasher application.
– Build the project: Build > Build Solution or <F7>.
– Load the code into the SAM L10 Xplained Pro and start debugging: Debug > Start debugging

and break or <ALT+F5>.
– The application is programmed and the debugger breaks in main.
– Run the code: Debug > Continue or <F5>.
– The example runs out of the Xplained Pro target.

 AN2722
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5. Getting Started With SAM L11 Secure Solution Using Atmel Studio 7
and Start

5.1 SAM L11 Security Concept Overview
Using the ATSAM L11 requires to be familiar with different security features and concepts that involve a
TrustZone® for ARMv8-M devices.

The TrustZone technology is a System-on-Chip (SoC) and MCU system-wide approach to security that
enables Secure and Non-Secure code to run on a MCU. It enables creating multiple software security
domains that restrict access to selected memory, peripherals, and I/O to trusted software without
compromising the system performances. The user can consider the following deployment approaches:

• Single-developer approach (Customer A)
• Dual-developer approach (Customer A+ Customer B)

The Single developer approach involves a unique developer (Customer A), which is in charge of the
following:

• Developing, deploying, and protecting the Secure code
• Developing and deploying the Non-Secure code

In the Dual-Developer approach, the first developer (Customer A) is in charge of developing the Secure
application and its associated Non-Secure callable library. The Secure Application must be loaded in the
SAM L11 NVM and protected.

A different developer (Customer B) will then start Non-Secured application development on a
preprogrammed SAM L11 with limited access to Secure resources (call to Non-Secure API only).

 AN2722
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Figure 5-1. Single-Developer and Dual Developer Approaches

1- Confidential – For Microchip internal use Only -
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This document describes how to debug a solution composed of the following two projects:

• Secure Project
• Non-Secure Project

Note:  Refer to the "SAM L11 Security Reference Guide" application note, which describes the security
features available in the Microchip SAM L11 microcontroller that fulfill the security requirement of most
embedded systems.
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5.2 Instructional Guide
Follow these steps to explore the Atmel Xplained Pro platform:

1. Download Atmel Studio.
2. Install Atmel Studio.
3. Launch Atmel Studio.

 AN2722
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4. Connect the DEBUG USB port on the kit to the PC using a micro-USB cable (Standard-A to Micro-
AB). When the Xplained Pro MCU kit is connected to the computer for the first time, the operating
system will install the software driver. The driver file supports 32-bit and 64-bit versions of
Microsoft® Windows®XP, Windows Vista®, Windows 7, Windows 8 and Windows10.

When the Xplained Pro MCU board is powered, the power LED (green) will glow. Atmel Studio will
auto-detect the specific Xplained Pro MCU and extension boards that are connected. Atmel Studio
will present relevant information, such as data sheets and kit documentation.

The ATSAML11E16A device is programmed and debugged by the on-board embedded debugger,
hence no external programmer or debugger tool is required.

Figure 5-2. Atmel Studio SAM L11 Xplained Pro Introduction

14 © 2016 Atmel Corporation
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5. Launch Atmel Start from Atmel Studio to Open the Secure Application Project: File > New > Atmel
Start Example Project and then open Atmel Start into Atmel studio 7.
Figure 5-3. Open a New Atmel Start Example Project in Atmel Studio

4 © 2016 Atmel Corporation

Note:  After few seconds the example llist will be displayed.
6. Select the "TrustZone Getting Started Example" for the Secure Project (TZ-GetStart-S) from the

examples list, and then click OPEN SELECTED EXAMPLE.
Figure 5-4. TrustZone Getting started SAM L11 Secure Project Example Selection

16 © 2016 Atmel Corporation
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7. Generate the project from Atmel Start to open it in Atmel Studio. Once the project is open, click
GENERATE PROJECT.
Figure 5-5. Atmel Start Secure Project Overview and Generation

17 © 2016 Atmel Corporation
8. The following "New Atmel Start Project" window will be displayed.

Figure 5-6. Secure Project Importation View

 AN2722
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9. Modify the following project information:
– Enter a new Project Name.
– Click Browse to choose a location.
– For Solution: Create New Solution.
– For Solution Name, enter TrustZoneGettingStarted.
– Cick OK to open the project in Atmel Studio.

Figure 5-7. Modifying the Project Information

 AN2722
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10. To see the project in the Atmel Studio Solution Explorer: View > Solution Explorer or <CTRL+ALT
+L>.
Figure 5-8. Atmel Studio Solution Explorer Showing Secure Project

19 © 2016 Atmel Corporation

Currently, the TrustZoneGettingStarted solution is only composed of the SecureProject.
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11. To compile the "TrustZoneGettingStarted " Secure application, build the project: Build > Build
Solution or <F7 >..
The current building of the project is important as it enables the generation of the Secure library
gateway used in the future Non-Secure application.

Figure 5-9. Secure Project Building Output Window

21 © 2016 Atmel Corporation
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The Secure Application is built, and the Secure library gateway has been generated in the
SecureProject /Debug folder:

Figure 5-10. Compilation Resulting Secure Library File
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12. Close the Atmel Start window from Atmel Studio.
13. Reopen a new Atmel Start Example Project to create the Non-Secure application:

– File > New > Atmel Start Example Project.
– Open Atmel START directly into Atmel Studio 7.

Figure 5-11. Open a New Atmel Start Example Project in Atmel Studio

4 © 2016 Atmel Corporation

14. Choose the "TrustZone Getting Started Example" for the Non-Secure Project (TZ-GetStart-NS)
from the existing examples list, and then click OPEN SELECTED EXAMPLE.
Figure 5-12. TrustZone Getting started SAM L11 Non-Secure Project Example Selection

25 © 2016 Atmel Corporation
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15. Generate the project from Atmel Start to open it in Atmel Studio, and once it is loaded, click
GENERATE PROJECT.
Figure 5-13. Atmel Start Non-Secure Project Overview and Generation

26 © 2016 Atmel Corporation
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16. The following "New Atmel Start Project " window will be displayed.
Figure 5-14. Non-Secure Project Importation Window
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17. Modify the project information as given below:
Figure 5-15. New Atmel Start Project

26 © 2016 Atmel Corporation

– Project Name: rename the project name to "NonSecure Project".
– Location: keep the same location as the Secure Application Project.
– Solution: Add to Solution.
– Souliton Name: Keep the same Solution name used for the Secure Project:

TrustZoneGettingStarted.
– Ensure that you Do not click the OK button now.

Important:  Make sure to select the adding option by clicking Add As Link.

Users need to complete these steps for the Non-Secure Project importation:

– Add the Secure Project Veneer Header file required to add the veneer functions used to
communicate between the Secure application and the Non-Secure application. The Secure
Project Veneer Header file is located in the SecureProjectFolder/trustzone folder. In this
example this file is called trustzone_veneer.h.

– Add the Secure Project Export Library file required to add the compiled library containing the
secure functions used to communicate between the Secure application and the Non-Secure
application. The Secure Project Export Library file is located in the SecureProjectFolder/
debug folder. In this example, this file is called libsecure_gateway_veneer.lib.

– Add the Non-Secure Project Linker Script file required to manage the memory allocation
(Non-Secure and Secure parts) for the Application Programming. The Non-Secure Project
Linker Script file is located in the SecureProjectFolder/ Device_Startup folder. In this example
this file is called saml11_nonsecure.ld.

 AN2722
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Figure 5-16. New Atmel Start Project Window

27 © 2016 Atmel Corporation

– Click OK to open the project in Atmel Studio.
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18. To see this project using the Atmel Studio Solution Explorer, select View/Solution Explorer or press
<CTRL+ALT+L>.
The Solution TrustZoneGettingStarted is now composed of these two projects. These two projects
are shown in the following figure.

– SecureProject
– NonSecureProject

Figure 5-17. Atmel Studio Solution Explorer Showing both Secure and Non-Secure Project

28 © 2016 Atmel Corporation
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19. Configure the Non-Secure project debugger/programmer interface. Open the project properties and
then perform this action: Project > Properties or press <ALT+F7>.

20. Click Tool.
– For the Selected debugger/programmer chose "EDBG ATMLxxx".
– For the Interface choose "SWD".

Figure 5-18. Programming Tool Selection for the Non-Secure Project

29 © 2016 Atmel Corporation

21. Compile the NonSecureProject: To build the project: Build > Build Solution or press <F7>. Check
and verify that no errors are reported.
Figure 5-19. Non-Secure Project Building Output Window

30 © 2016 Atmel Corporation
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22. Configure the SecureProject and NonSecureProject for cross-debugging.
– Fom the Solution Explorer Window, right-click on the SecureProject file and choose

properties.
Figure 5-20. How to access Project Properties in Atmel Studio

31 © 2016 Atmel Corporation
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– From the SecureProject Properties Window, click Advanced.
Figure 5-21. Advanced Project Properties Tab

32 © 2016 Atmel Corporation

– Click Add to add the NonSecureProject.elf file to the SecureProject additional modules. The
NonSecureProject.elf is a compiled file located in the NonSecureProjectFolder/Debug folder.
Figure 5-22. .elf File Selection

1

2

3
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The NonSecureProject.elf file now accesses part of the SecureProject additional modules as
shown:

Figure 5-23. NonSecureProject Properties Window

34 © 2016 Atmel Corporation

– To complete this step, save current properties: File > SaveSecureProject.

– From the Solution Explorer window, right-click on the NonSecureProject file and choose
Properties.

– From the NonSecureProject Properties, click Advanced.
– Click Add to add the SecureProject.elf file to the NonSecureProject additional modules.

Note:  The SecureProject.elf is a compiled file located in the SecureProjectFolder/debug
folder. The SecureProject.elf file becomes an accesses part of the SecureProject additional
modules as described:

Figure 5-24. NonSecureProject Properties Window

35 © 2016 Atmel Corporation

– To complete this step, save current properties by doing this action: File > SaveSecureProject.
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23. To set Breakpoints to debug the complete TrustZone Solution, follow these steps:
– Set a break point in the NonSecure Project.
– Deploy the NonSecureProject file in the Solution Explorer Window, and open the main.c file.
– Double-click on the related line to add the breakpoint.

Figure 5-25. Atmel Studio IDE Overview: Break Point Location

36 © 2016 Atmel Corporation

In this case, the breakpoint is placed at the line that calls the Non-Secure callable function1,
nsc_func_plus3. This function is declared into the libsecure_gateway_veneer.lib file,
which is generated once the SecureProject is built.

The call to the secure function, func_plus3, is done in the veneer (Secure Gateway), and the
declaration is done in the main.c file of the SecureProject.

– Set a breakpoint into the Secure gateway trustzone_veneer.c file, at the return
func_plus3(x); line.

 AN2722
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Figure 5-26. Atmel Studio IDE Overview: Break Point Hit in the Secure Gateway Veneer
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– Set a breakpoint into the SecureProject main.c file at the func_plus3 declaration.
Figure 5-27. Atmel Studio IDE Overview: Breakpoint Hit in the Secure Project

37 © 2016 Atmel Corporation
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– Debug your project and see the breakpoint hit in the Non-Secure project, then in the Secure
project follow these steps:

• Click  or press <F5> to start and execute a new debug session. The execution halts
at the first breakpoint located in the NonSecureProject.
Figure 5-28. Debug Session Window

38 © 2016 Atmel Corporation

– Click  again or press < F5> to continue the debug the session. The execution
halts at the second breakpoint located in the Secure gateway
(trustzone_veneer.c).

– Click  again or press < F5> to continue the debug the session. The execution
halts at the third breakpoint located in the SecureProject.

 AN2722
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Figure 5-29. Debug Session Window

39 © 2016 Atmel Corporation

Note:  Now both the Secure and Non-Secure projects can be debugged without any restrictions.
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The Microchip Web Site

Microchip provides online support via our web site at http://www.microchip.com/. This web site is used as
a means to make files and information easily available to customers. Accessible by using your favorite
Internet browser, the web site contains the following information:

• Product Support – Data sheets and errata, application notes and sample programs, design
resources, user’s guides and hardware support documents, latest software releases and archived
software

• General Technical Support – Frequently Asked Questions (FAQ), technical support requests,
online discussion groups, Microchip consultant program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases,
listing of seminars and events, listings of Microchip sales offices, distributors and factory
representatives

Customer Change Notification Service

Microchip’s customer notification service helps keep customers current on Microchip products.
Subscribers will receive e-mail notification whenever there are changes, updates, revisions or errata
related to a specified product family or development tool of interest.

To register, access the Microchip web site at http://www.microchip.com/. Under “Support”, click on
“Customer Change Notification” and follow the registration instructions.

Customer Support

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Field Application Engineer (FAE)
• Technical Support

Customers should contact their distributor, representative or Field Application Engineer (FAE) for support.
Local sales offices are also available to help customers. A listing of sales offices and locations is included
in the back of this document.

Technical support is available through the web site at: http://www.microchip.com/support

Microchip Devices Code Protection Feature

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is one of the most secure families of its kind on the

market today, when used in the intended manner and under normal conditions.
• There are dishonest and possibly illegal methods used to breach the code protection feature. All of

these methods, to our knowledge, require using the Microchip products in a manner outside the
operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is
engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.
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• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their
code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the
code protection features of our products. Attempts to break Microchip’s code protection feature may be a
violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software
or other copyrighted work, you may have a right to sue for relief under that Act.

Legal Notice

Information contained in this publication regarding device applications and the like is provided only for
your convenience and may be superseded by updates. It is your responsibility to ensure that your
application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS
CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE.
Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life
support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual
property rights unless otherwise stated.
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